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Corporations (1120)

The basics of data entry for a corporation (1120, 1120-C, 1120-H) return are the same 
as for a 1040 return. Field- and screen-level help, shortcut keys, and navigation 
throughout data entry all function as they do in the 1040 program. See the Drake Soft-
ware User’s Manual: Tax Year 2011 for the basics of using the program. 

What’s New in Drake for Corporations

Drake programs its tax software according to the latest IRS rules and regulations. The 
2011 program reflects all changes to credits and deductions, including discontinua-
tions. For details on the new regulations for the 2011 tax year, see the IRS instructions 
for Form 1120.

ELEC Screen

The ELEC screen has been revised for easier, more efficient selection of various elec-
tions available to corporations. For more information on choosing elections in Drake, 
see “Elections” on page 31.

Income and Deduction Screens

The data entry screens for income and deductions have been revised for easier data 
entry. 

Only three screens are now required:

• INC – Income

• DED – Deductions

• J – Loss Carryback, Tax Computation, and Payments

Screens 3, 4, and TAX have been eliminated from the 1120 package.

Multi-State Apportionment

Previously, in order to prepare a multi-state return in Drake—for a company doing 
business in more than one state—you had to go to each individual state’s screens and 
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enter its sales, payroll, and property factors. Drake would then calculate the apportion-
ment factor on that state’s tax form.

With the new APPT screen, you can enter the apportionment information for all states 
in one global location. The link to the APPT screen can be found on the States tab, or 
you enter APPT in the selector field and press ENTER. 

General Business Credit (Form 3800)

The screen used to fill out Form 3800, General Business Credit, has been changed in 
Drake Software for tax year 2011 due to the IRS’s redesign of the form. The 3800 
screen now calculates amounts for Form 3800, Part III, General Business Credits or 
Eligible Small Business Credits. Enter on screen 3800 any passive activity credits 
allowed and any current-year unused credits to carry back to prior years. 

These changes have been added to all applicable packages in Drake.

GBC Screen New for 2011, the GBC screen is used for reporting the following types of informa-
tion:

• Data for current-year credits that are reported on forms Drake does not support 
(To enter data for a credit programmed into Drake, use the credit’s screen—for 
example, use the 8820 screen for Form 8820, Orphan Drug Credit.)

• GBC and ESBC carryforwards and carrybacks

Carryover 
Attachment

A General Business Credit Carryover Attachment (ATT_3800), printed for each credit 
carryover to 2011, includes the following IRS–required information:

• Description of credit (selected from drop list)

• Year the credit originated

• Original amount of credit

• Original credit allowed

• Information on amount changed, if needed

• Year and amount of credit carryback used

• Year and amount of credit carryforward used

Unused GBC 
Worksheet

A Current Year Unused General Business Credit worksheet (WK3800CO), printed for 
each current-year credit carryover to 2012, includes the following information:

• The credits listed in order of allowed use from the Form 3800 instructions

• Original amount of credit

• Original credit allowed

• Year and amount of credit carryback used

• Carryforward amount

NOTE
Part III was added to the form this year to reflect all the general busi-
ness credits reported on Form 3800 and to identify the type of credit 
being reported: General Business Credits (GBC) or Eligible Small Busi-
ness Credits (ESBC).
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Cost of Goods Sold (Form 1125-A)

In years past, Schedule A, Cost of Goods Sold, was located on page 2 of Form 1120. 
Beginning with tax year 2011, entries on screen A produce a separate form, Form 
1125-A, Cost of Goods Sold.

Officer Information (Form 1125-E)

In years past, Schedule E, Compensation for Officers, was located at the bottom of 
page 2 of Form 1120. Beginning with tax year 2011, entries on screen E produce a 
separate form, Form 1125-E, Compensation of Officers.

Form 5472 Screens

The screens for filling out Form 5472, Information Return of a 25% Foreign-Owned 
U.S. Corporation or a Foreign Corporation Engaged in a U.S. Trade or Business, have 
been redesigned. As shown in Figure 1, Form 5472 screens are accessible via the 25% 
Foreign-Owned U.S. Corporation box under the an Other Forms tab of the Data 
Entry Menu.

Figure 1: Screens for accessing Form 5472 fields

Changes for 2011 are described below.

• Parts I, III, IV, V, and VI are included under the 5472 menu option (see Figure 1). 
On this screen are tabs for accessing the separate parts.

• Part II is included on a separate screen (screen 2X) to allow multiple screens with 
the same multi-form code.

• A multi-form code field has been added for matching the Part I and Part II screens 
to each other.

• It is no longer necessary to use the name and identifying number from Part III, 
Related Party, in order to tie the 5472 screens together.

Although the layout of the screens is different from 2010, the remaining data entry 
fields and form output has remained unchanged for 2011.

8609 Screen

The 8609 screen (for Form 8609, Low-Income Housing Credit Allocation and Certifi-
cation) has been reorganized for easier data entry. Among the changes:

• Fields required for both Form 8609 and Form 8609-A are now separated on the 
screen from the other information fields.

• Other fields for Form 8609-A are now located in the middle of the screen.
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• Other fields for Form 8609 are now located in the bottom half of the screen.

• Screen 8586 has been removed from the program. The program will generate 
Form 8586, Low Income Housing Credit, depending on entries made to screens 
8609 and K1P.

Book Depreciation Schedules

A book depreciation schedule will now be printed when the Carry book accumu-
lated depreciation & amortization to Schedule L check box is marked on the L 
screen (if a 4562 screen has also been completed.)

Adjustment and Override Worksheets

The Adjustment Worksheet and Override Worksheet are updated each year to help you 
understand what happens in the return when certain data is changed through the use of 
adjustment or override fields (Figure 2). 

Figure 2: Adjustment (+/-) and override (=) fields

By default, fields that allow overrides are preceded by an equal sign (=) and display 
red text. Data entered in these fields replaces, or overrides, program calculations. 
Fields that allow adjustments are preceded by a plus/minus sign (+/-) and display blue 
text. Data in these fields adjust program calculations by the amount entered. A posi-
tive number increases the calculated amount; a negative number decreases it.

The Adjustment and Override worksheets are available through the FAQ screen. To 
access them, open the FAQ screen, click the Screen Help button (or press 
CTRL+ALT+?) and click the links at the top of the window.

Before You Start

Actions you might need to take before starting a 1120 return in Drake include:

• Updating a prior-year return (if you prepared the tax return last year)

• Changing a return from another type of return to an 1120, if the corporation has 
made such a change in the last year

Updating a Prior-Year Return in Drake

A prior-year return can be updated in three ways:

• With all other returns in the program using Last Year Data > Update Clients 
2010 to 2011 (not recommended)

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2010 to 2011 (recommended) 
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• When you open a return for the first time in the 2011 program and are prompted to 
update it

When you update an 1120 return that was marked “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

Converting from Another Return Type

If the corporation is electing to become an 1120 corporation after existing as another 
type of entity (S corporation, partnership, etc.), it is necessary to indicate this in the 
program.

To change from another type of entity to an 1120 corporation in the program:

1. From the Home window, select Tools > File Maintenance > Change File Type.

2. Enter the EIN of the entity and click Continue.

3. Select the new return type.

4. Click Continue to save the change.

5. Click OK.

Filing Form 1120-C or 1120-H

No preliminary steps are required for Forms 1120-C or 1120-H. Use the same screens 
you might for an 1120 return, but include one of the following screens in addition:

• 20C — For Form 1120-C, U.S. Income Tax Return for Cooperative Associations

• H — For  Form 1120-H, U.S. Income Tax Return for Homeowners Associations

If one of these screens contains data, the program automatically produces the type of 
return indicated. For example, if a deduction is entered on screen 20C, an 1120-C 
return will be produced.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1120 (or Form 1120-C or 1120-H, as applicable).

Name and Address

Use screen 1 to enter the corporation name and address for Form 1120. For state pur-
poses only, if the corporation has an alternate address (such as a P.O. box), you can 

TIP
Is Form 1120-C or 1120-H being produced in error? Check the corre-
sponding screen (20C or H) for data entered. To delete a screen, open 
the screen to delete and press CTRL+D.
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enter that address on screen 2, State General Information, in the Address Line 2 
field at the bottom of the screen.

Tax Year

The software uses the calendar year as the default tax period for all corporate returns; 
no date entries are required on screen 1 for a December 31 tax year end.

Fiscal and 
Calendar 

Years

If the corporation uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not calendar 
year section in the lower-left corner of screen 1.

Short-Year 
Returns

An entity may have a short-year return if changing accounting periods with IRS 
approval (Form 3115), or if this is its first or last year in business and the tax year is 
not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate 
the beginning and ending dates for the current year.

If filing a short-year return (other than an initial or final return), you have to provide 
an explanation. To do so, go to the ELEC screen and select an explanation from the 
Other short year options/elections drop list. Your explanation will be displayed at 
the top of the first page of the tax return. If you do not select an explanation, an EF 
message will be generated with the return, and the return cannot be e-filed.

NEW FOR

 2011
The screen 2, State General Information link is now located on the 
States tab of the Data Entry Menu.

NOTE
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 35.

NOTE
For more information on short-year explanations, see IRS Pub. 4163.

The program may not correctly calculate depreciation, gains, or losses 
for a short-year return. Depreciation for a short-year return can be 
entered on screen 4562 and/or screens 6, 7, 8, and 9.
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Boxes A through E

Use screen 1 to enter most information for boxes A through E (top of Form 1120). 
Note that boxes A-4 (“Schedule M-3 attached”) and D (“Total assets”) are completed 
automatically by the program based on data entered elsewhere.

Income and Deductions

The data entry screens for income and deductions have been revised for easier data 
entry. Prior to tax year 2011, data entry was required on the following screens in order 
to calculate taxable income for a return:

• 3 (Income and Deductions)

• 4 (Payments and Credits)

• INC (Other Income)

• TAX (Taxes and Licenses)

• DED (Other Deductions)

• J (Schedule J, Tax Computation)

Only three screens are now required:

• INC — Includes all items of income reported on Form 1120, page 1, lines 1 
through 10, that do not require a separate schedule (Schedule C) or additional 
information (Income reported on Form 1065, Schedule K-1); also includes tax-
exempt interest income reported on the Schedule K.

• DED — Includes all deduction items reported on Form 1120, page 1, lines 13 
through 26, that do not require a separate schedule or form (Form 4562).

• J — Includes loss carrybacks, controlled group tax bracket amounts, tax payment 
information, and certain credits.

Gross Receipts

Enter gross receipts (Form 1120, line 1b) and returns and allowances (Form 1120, line 
1d) on lines 1b and 1d of the INC screen. Exclude any amounts that are to be reported 
on lines 4 through 10 of Form 1120.

Cost of Goods Sold (Form 1125-A)

New for 2011 is Form 1125-A, Cost of Good Sold. This form replaces the Schedule A.

NOTE
Box 1a (“Consolidated return”) is automatically marked if there are 
entries on screen 851 (Form 851, Affiliations Schedule). Box 2 (“Per-
sonal holding company”) is automatically marked if there are entries on 
screen PH (Schedule PH, U.S. Personal Holding Company (PHC) Tax).

NOTE
Line 1a, Merchant card and third-party network payments, is new for 
Form 1120 in 2011; however, because the IRS requires that a zero (0) 
be entered on this line for 2011, the field for line 1a on the INC screen 
is inactive (grayed-out).
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As in years past, for cost of goods sold (COGS), complete screen A. Form 1125-A is 
not produced unless entries are made on screen A. 

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories”).

Line 5, Other 
Costs

Line 5, “Other costs,” is designated for any applicable costs not entered on lines 2 
through 4 (purchases, cost of labor, and additional section 263A costs). In Drake, two 
data-entry fields are used to complete line 5: one for other costs excluding deprecia-
tion, and one for depreciation (Figure 3).

Figure 3: Screen A (Schedule A), line 5

In the Depreciation field, enter any depreciation that relates to the cost of goods sold 
(unless the amount is flowing from the 4562 Detail screen with COGS selected from 
the For drop list). Note that this field of screen A is an override field; an entry here 
overrides calculations from the 4562 screen. Amounts entered in this field automati-
cally adjust the total depreciation that is carried to page 1 of Form 1120. For Other 
costs - excluding depreciation, use a CTRL+W worksheet. The depreciation amount 
is included on the statement for other costs and should not be included in the Other 
Costs worksheet.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 39), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in the fields in data entry. When the trial balance is imported, 
the COGS depreciation expense amount flows directly to the appropriate line of Form 
1125-A and is calculated accordingly.

Dividends (Schedule C)

Enter dividends and special deductions on screen C (Schedule C). The Dividends 
Received Deduction Worksheet (WK_DRD) is generated from data entered in these 
fields. The result of the WK_DRD is carried to Schedule C of the return. The total 

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Form 1125-A. For more information on completing these 
fields, press F1 or consult the IRS instructions.

NOTES

Lines 1 and 7 of screen A are adjustment fields. Amounts entered in 
these fields adjust (add to or subtract from) any amount being carried 
from the F screen (Form 1040, Schedule F, Profit or Loss from Farming) 
to line 2 of Form 1120.

The fields on screen L (Schedule L - Balance Sheet - Assets) for line 
3 “Inventories” are override fields. Anything entered in these fields over-
rides (replaces) the data entered for inventory on screen A.
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from Schedule C, line 19, column A, is carried to Form 1120, line 4 (“Dividends”), 
and the total from Schedule C, line 20, column C, is carried to Form 1120, line 29b 
(“Special deductions”),

Interest

Line 5 of Form 1120 is for interest income, which is entered on the INC screen. Note 
that the Interest income field is an adjustment field; an amount entered there is com-
bined with the interest amount, if any, entered on screen 6252 (Form 6252, Installment 
Sale Income) and interest income entered on screen K1P (Schedule K-1, Form 1065).

Enter tax-exempt interest income on the INC screen. This amount flows, as applica-
ble, to Schedule K, line 9, and to Schedule M-1, line 7. Override fields are available 
on screens K and M1 if necessary to override the INC screen amount.

Rents and Royalties

Enter gross rents and gross royalties using the direct-entry fields on the INC screen. 
Note that passive activity loss rules may be applied to rental activities held by a 
closely held corporation or a personal service corporation.

Capital Gains

Use screen D (Schedule D) to enter capital gains and losses. The net gain from screen 
D is carried to line 8 of Form 1120. (Any net capital loss is carried to the ATT_D 
attachment to offset future gains.)

Ordinary Gains and Losses

The amount generated on line 9 flows from screen 4797. Amounts can also flow from 
screen 4562 to Form 4797 (making screen 4797 entries unnecessary), but only if 
screen 4562 shows assets sold, date, and property type.

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View mode of the 
return.

For Form 1120, calculated amounts from the following screens also flow automati-
cally to the “Other income” line (line 10):

• Screen 6478 (Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit)

NOTE If the corporation is filing a consolidated return, do not enter non-
included dividends here or anywhere else in the program.

NOTE
You can import data for Schedule D using the Schedule D Import fea-
ture. For more on using this feature, see “Schedule D Imports” in Chap-
ter 5 of the Drake Software User’s Manual: Tax Year 2011.
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• Screen 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields for other income on the INC screen include:

• Amount of credit for tax on fuels

• Interest income on receivables

• Recoveries of bad debts

• Section 481 adjustments

• State tax refund

• Taxable income from insurance proceeds

• Other (itemize) (Detail worksheet is required.) 

Compensation of Officers (Form 1125-E)

New for 2011, Form 1125-E, Compensation of Officers (formerly Schedule E) is not 
generated automatically with the return unless it is required—in other words, unless 
total receipts (line 1b, plus lines 4 through 10) on Form 1120 are $500,000 or more. To 
force the software to print Form 1125-E, from the PRNT screen, select Force Form 
1125-E, Officer Compensation.

Entering 
Comp Data

Use screen E to enter officer information and compensation amounts. Press PAGE 
DOWN to enter additional officers. Screen E totals are calculated and carried to line 12 
of Form 1120.

The total of officer compensation can be entered in the Officer Compensation over-
ride field on the DED screen (generally used when Form 1125-E is not required). An 
entry in that field overrides any calculations from screen E, changing lines 12 and 27 
of the 1120 but not Form 1125-E.

Screen E 
Check Boxes

Screen E has two check boxes: Signs return, and Books in care of. Mark the applica-
ble box on the screen that identifies the officer who either signs the federal or state 
paper returns, or is the contact person for the books (state return only).

Ownership & 
Participation

The Ownership and Participation fields on screen E are required. Fields are as fol-
lows:

• Total — Enter the officer’s ownership percentage.

• Common — Enter the percentage of common stock owned by the officer.

• Preferred — Enter the percentage of preferred stock owned by the officer.

• Time — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

NOTE
Data for the “Ordinary income from partnerships” worksheet should be 
entered on the K1P screen and must contain the partnership’s name, 
EIN, and amount of income (or loss), all on one line. Losses are 
included with “Other Deductions” entered on the DED screen.
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Salaries and Wages

Use the DED screen to enter salaries and wages paid. Note that the DED screen 
amount is reduced by the amount, if any, of credit from Form 5884.

Repairs and Maintenance

Enter repair and maintenance costs on the DED screen. An amount entered here is 
combined with the amount, if any, entered in the Repairs and maintenance field on 
screen F.

Bad Debts

Use the Bad debts field on the DED screen to enter the total debts that became worth-
less in whole or in part during the year, but only to the extent that such debts related to 
a trade or business activity.

Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the corporation rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the entity, and then complete 
Part V of the 4562 (screens 8 and 9). 

Taxes and Licenses

Enter tax and license amounts in the Taxes and licenses section of the DED screen. 
Amounts are combined and the sum generated on Form 1120, line 17 (“Taxes and 
licenses”). Note that credit from Form 8846 (Credit for Employer Social Security and 
Medicare Taxes Paid on Certain Employee Tips) adjusts the line 17 amount.

NOTE
The Salaries and wages amount should not include compensation of 
officers. Enter officer compensation data on screen E or as Officer 
Compensation on line 12 of the DED screen.

NOTE
Enter deductible non-business bad debts as a short-term capital loss on 
screen D (Capital Gains and Losses).

Cash method corporations cannot take a bad debt as a deduction 
unless the amount was previously included in income.

NOTE The Rents field is an adjustment field. An amount entered here is com-
bined with the amount, if any, entered in the Rent fields on screen F.

NOTE
These amounts also appear on the Taxes and Licenses Attachment 
(ATT_CTL), referred to on line 17 with an “ATT_CTL” reference. To 
keep the notification from appearing, go to the PRNT screen and select 
Suppress printing form and attachment references.
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State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen are carried to the tax computation (ATT_TAX) worksheet. The state tax 
amount carried from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used.

Interest

Enter interest expense on the DED screen. Note that the Interest expense field is an 
adjustment field. Any amount entered here is combined with the amount, if any, 
entered in the Interest fields on screen F. 

Charitable Contributions

The DED screen provides two fields for entering data for line 19, Charitable contribu-
tions.

Figure 4: Charitable contribution lines on the DED screen

• Contributions — Enter the gross amount of contributions for the year that are 
subject to the 10% limit on deduction.

• Qualified conservation contributions — Enter the gross amount of contribu-
tions for the year that are not subject to the 10% limit. These contributions have a 
carryover period of 15 years; see IRS instructions for details.

The program calculates the contributions allowed and determines carryover capability 
for amounts entered in both fields for line 19 and reflects the applicable amount on 
Form 1120. (Refer to the contribution limitation/carryover worksheet (WK_CNTRB) 
for calculation of allowed amount.) Contribution carryovers from prior years are 
entered on the LOSS screen.

Depreciation

Enter depreciation on the 4562 screen. Select a form from the For drop list (Figure 5) 
to associate the depreciable item with the correct form or activity. Data from the 4562 
screens is calculated and carried to Form 1120 and to the selected schedules or forms.
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Figure 5: Selecting Form 1120 from the 4562 screen For drop list

Depletion

Enter depletion deductions on the DED screen. See Form 1120 instructions and Pub. 
535 for more information on depletion.

Advertising

Enter advertising expenses on the DED screen.

Pension and Profit-Sharing

The software reduces this expense based on the credit amount calculated from Form 
8881, Credit for Small Employer Pension Plan Startup Costs.

Domestic Production Activities

Use screen 8903 to complete Form 8903, Domestic Production Activities Deduction 
(DPAD). The calculated total of screen 8903 flows to line 25 of Form 1120.

Other Deductions

Enter all other deductions on the DED screen. The program calculates these amounts 
and incorporates the total into line 26 (“Other deductions”) of Form 1120. The follow-
ing deductions, credits, adjustments, and exclusions also flow to line 26:

• Amortization from Form 4562

• Credit from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

NOTE For more on the For drop list in Drake, see “Associating One Screen 
with Another,” in the Drake Software User’s Manual: Tax Year 2011

NOTE The DPAD is not allowed on returns with a net operating loss (NOL) for 
the current year. It also cannot be used to create a current-year loss.
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NOL Carrybacks and Carryforwards

Enter NOL carrybacks from future years to the current year on screen J. To enter mul-
tiple carryback amounts, use a detail (CTRL+W) worksheet.

Use the LOSS screen to enter NOL carryforwards, capital losses, and contribution 
carryforwards from prior years. Use screen J to enter current-year carrybacks to prior 
years.

Tax, Refundable Credits, and Payments

Screen J (Loss Carryback, Tax Computation, and Payments) has fields for completing 
the “Tax and Payments” section of Form 1120. Note that some fields are overrides. 
Press F1 to view more information on a field.

Total Tax

For corporations that belong to a controlled group, complete all applicable fields on 
screen J. If allocating income to the various brackets on this screen, you must enter 0 
(zero) in the fields of the brackets to which no income is allocated.

The total tax from Schedule J is calculated and carried to line 31 of Form 1120.

Estimated Taxes and Applied Refunds

Enter on screen ES the estimated corporate taxes paid. If necessary, use screen W to 
override 2011 estimated taxes paid and apply any overpayments from 2011 to 2012.

Over- 
payment

To apply the current-year overpayment to next year, the corporation’s current-year 
taxable income must be greater than 0 (zero). Enter the amount to be carried to next 
year in the overpayment field at the bottom of screen W. If current-year taxable 
income is not greater than 0 and you want to apply the current-year overpayment to 
next year, enter a positive amount on line 1, Taxable income expected for the tax 
year, at the top of screen W.

NOTE
Drake automatically calculates meals and entertainment limitations.

A detail (CTRL+W) worksheet is required for the “Other (itemize)” field. 
The program automatically generates a worksheet if an entry is made 
here, or in any other field where a worksheet is required by the IRS.

NOTE
Controlled groups are also required to complete Schedule O. Use the O 
screen in Drake to complete Schedule O. See “Schedule O (Controlled 
Group Information)” on page 29.

NOTE Estimate vouchers are not used in federal corporation tax returns.
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Quick 
Refund

To file Form 4466, Corporation Application for Quick Refund of Overpayment of 
Estimated Tax, go to the PRNT screen and mark the Calculate Form 4466 box. This 
is the only entry necessary to produce the form.

Under-
payment

Use screen 2220 to enter information for Form 2220, Underpayment of Estimated Tax 
by Corporations. Note that the 2220 screen in Drake consists of two screens. Press 
PAGE UP and PAGE DOWN to move from screen to screen.

State 
Estimates

Enter 2011 estimates and 2012 overpayments for state returns on the ES screen. For 
the federal return, to override 2011 estimates and apply overpayments to 2012, use 
screen W.

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporation’s refund to be direct-deposited. To 
access this form in Drake, go to the DD screen, accessible from the General tab.

When filling out the DD screen:

• If the federal refund is to go to the account listed, select Yes for the Federal 
Account selection; otherwise, select No. (Default is Yes.)

• If a state refund is to go to the account listed, select the state abbreviation from the 
State/City selection drop list.

• Enter the name of the financial institution, the routing number (RTN), the account 
number, and the type of account (Checking or Savings).

• Re-enter the routing number, account number, and type of account to verify. 
(Figure 6)

Figure 6: Federal section of DD screen (also 8050 screen)

If receiving refunds from different state tax authorities, use the State Account boxes 
on the DD screen to indicate where other state refunds should be deposited.

Electronic Funds Withdrawal (Direct Debit)

Use the PMT screen, accessible from the General tab, to indicate that the balance due 
for an e-filed return should be withdrawn (direct-debited) from an account.

IMPORTANT
The program retains the underpayment and penalty rates as of 
12/31 of the calendar year. If a corporation has a fiscal year end, 
you must enter the effective rates manually.
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Program Defaults and Overrides

By default, the program indicates that the entire balance due (line 34, “Amount 
owed,” of Form 1120) is to be withdrawn on the return due date. To indicate other-
wise, complete the Requested payment date override fields (see Figure 7) for the 
applicable payment. If the return is e-filed on or before the due date, the requested 
payment date cannot be later than the due date. If the return is transmitted after the due 
date, the requested payment date cannot be later than the date the return is transmitted.

Required Information

A Withdrawal selection (item 1 in Figure 7) is required if the program is to direct tax 
authorities to withdraw funds from the corporation’s bank account.

Figure 7: Required fields on PMT screen: withdrawal selection (1);
account information (2); specified return (3)

The name of the financial institution, RTN, account number, and account type are 
required. As with the DD screen, the RTN, Account number, and Type of account 
data must be entered twice (item 2 in Figure 7).

Finally, the PMT screen must indicate the return to which the payment data applies 
(item 3 in Figure 7). Mark the box of the applicable return type: 1120, 7004, or 1120X.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or 
state taxes. To have state amounts withdrawn from an account other than the account 
indicated for federal payments, complete the fields in the State Account sections of 
the PMT screen. 

Filing an Extension

Calendar year returns are due on March 15, 2012. By filing Form 7004, a corporation 
can extend the deadline six months to September 15. Fiscal year returns are due on the 

NOTE Neither the federal nor the state balance due can be paid from more 
than one account.
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15th day of the third month after the end of the corporation’s year. The 7004 extends 
the deadline six months.

Use one of the following options to file an extension for an 1120, 1120-C, or 1120-H:

• Go to the 7004 screen in Drake and select Generate an extension. Complete any 
other applicable fields on the screen.

• Go to the PRNT screen and select Prepare Form 7004 extension based on 
screen 1 info.

Signing the Return

Electronic (PIN) signatures are required for e-filed returns. If e-filing a return, com-
plete all fields on the PIN screen. A return cannot be e-filed if the PIN screen fields, 
including the title and signature (name) of the officer signing the return, are not com-
pleted. 

An 1120 return must be signed and dated by one of the following individuals:

• The corporation’s president, vice president, treasurer, assistant treasurer, or chief 
accounting officer

• Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided. If it is prepared by an employee 
or officer of the corporation, select NONE in the Firm # and Preparer # drop lists on 
screen 1.

To have the preparer’s name and address information displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same:

– Go to the PRNT screen for the return and complete the field labeled PIN for 
preparer’s alternative electronic signature. The PIN entered should match 
the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

NOTE An 1120 return is due no later than eight and a half months after the 
close of the corporation’s tax year.

NOTE Setup > ERO must still be completed in Drake for e-filing. See the IRS 
instructions for further details on signing requirements.
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Amending a Return

The program can automatically fill the 1120X screen for Form 1120X, Amended U.S. 
Corporation Income Tax Return.

Returns 
Previously 

Prepared in 
Drake

From the Data Entry Menu of an 1120 return, enter an X in the selector field and 
press ENTER. (Screen X is also accessible from the first Other Forms tab.) At the 
prompt, select Yes to automatically fill the screen with data from the original return 
(that is, the return as originally entered in Drake). If the corporation’s name and 
address information has changed, enter the new information on screen X. Make all 
other necessary changes to the regular data entry screens.

Open screen 2X (or press PAGE DOWN while in screen X). Enter the line number from 
the X screen that corresponds with the changes that were made in data entry. (For 
instance, if you made a change in the tax on screen J, enter 4 (for “Tax”) in the Line 
Number field of the 2X screen.) Enter an explanation in the Explanation of Changes 
text box.

If more than one item was changed in data entry, press PAGE DOWN to open another 
screen 2X. Enter the line number from screen X that corresponds to this change and 
enter another explanation.

When you go to View mode, the program calculates the amended return.

New Returns To amend a return not previously prepared in Drake, create an 1120 return in Drake 
and open screen X. Complete the applicable fields on this screen, and then enter the 
amended data in the appropriate other screens, as described in the example below.

Example: An 1120 return was filed using a different tax software, but gross rental 
income was not reported on line 6. To amend the return:

1. From the Data Entry Menu of an 1120 return, open screen X.

2. Complete all applicable fields on screen X.

3. Close screen X and open the INC screen.

4. Enter the amount of unreported income on line 6.

5. Close the INC screen and open screen 2X.

6. Enter the line number from the X screen that corresponds with the changes that 
were made in data entry. (For this instance, if you made a change to income on the 
INC screen, enter 1 (for Total Income) in the Line Number field of the 2X 
screen.

7. Enter an explanation in the Explanation of Changes text box.

8. Calculate and view the return. Note the adjustments made on the Form 1120X.

CAUTION

When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, you 
should archive the original to avoid losing previously submitted data. 
For more information on archiving returns, see “Archive Manager” in 
Chapter 6, “Return Results,” of the Drake Software User’s Manual: 
Tax Year 2011.
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E-filing an 
Amended 

Return

To add Form 1120X to the queue for e-filing, go to the EF screen for the return and 
mark the 1120-X box. For detailed instructions on e-filing the returns in the queue, see 
Chapter 7, “E-filing,” in the Drake Software User’s Manual: Tax Year 2011.

Schedule K

Use screen K to enter data for Schedule K, Other Information. Screen K should also 
be used for Schedule K of Form 1120-C. Detailed here are some specific areas that 
might need your attention.

Schedule K, Line 3

On line 3 (line 5 for 1120-C), enter the EIN and name of the parent corporation if the 
corporation is a subsidiary in an affiliated group or a parent-subsidiary controlled 
group.

Be aware of the following guidelines from the IRS:

• “If the corporation is an ‘excluded member’ of a controlled group (see section 
1563(b)(2)), it is still considered a member of a controlled group for this purpose.

• “An affiliated group is one or more chains of includible corporations (section 
1504(a)) connected through stock ownership with a common parent corporation. 
The common parent must be an includible corporation and the following require-
ments must be met.

• “The common parent must own directly stock that represents at least 80% of the 
total voting power and at least 80% of the total value of the stock of at least one of 
the other includible corporations.

• “Stock that represents at least 80% of the total voting power and at least 80% of 
the total value of the stock of each of the other corporations (except for the com-
mon parent) must be owned directly by one or more of the other includible corpo-
rations.

• “For this purpose, the term ‘stock’ generally does not include any stock that (a) is 
nonvoting, (b) is nonconvertible, (c) is limited and preferred as to dividends and 
does not participate significantly in corporate growth, and (d) has redemption and 
liquidation rights that do not exceed the issue price of the stock (except for a rea-
sonable redemption or liquidation premium). See section 1504(a)(4). See section 
1563(d)(1) for the definition of stock for purposes of determining stock owner-
ship.”

Schedule K, Line 4

If a corporation, partnership, trust, individual, or estate owned, directly or indirectly, 
20 percent or more, or owned, directly or indirectly, 50 percent or more of the total 
voting power of all classes of the corporation’s stock entitled to vote, the applicable 
data appears on Schedule G. In Drake, Schedule G data is entered on screens G1 and 
G2, accessible through the G1 Screen and G2 Screen links on line 4 of screen K, or 
from the Data Entry Menu.
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If the stock is owned by any foreign or domestic corporation, partnership, or trust, 
enter on screen G1 the name and EIN of the entity, the type of entity (corporation, 
partnership, or trust), the country of the entity’s organization, and the percentage of 
stock the entity owns.

If the stock is owned by an individual or estate, enter on screen G2 the name and ID 
number of the individual or estate, country of citizenship, and percentage of stock 
owned. 

Use the CTRL+PAGE DOWN function to open additional (blank) G1 or G2 screens. For 
more information on line 4 of Schedule K, see the IRS instructions.

Schedule K, Line 5

If the corporation owned stock in other corporations or partnerships, or the beneficial 
interest in a trust, enter the information on the K5A or K5B screen. Click the K5A 
Screen or K5B Screen links to access fields for entering this information.

Use the CTRL+PAGE DOWN function to open additional (blank) K5A or K5B screens. 
For more information on line 5 of Schedule K, see the IRS instructions.

Schedule K, Line 7

Enter information on line 7 of screen K if a foreign person owned, directly or indi-
rectly, at least 25% of the total voting power of all classes of the corporation’s stock 
entitled to vote, or the total value of all classes of stock of the corporation. (If there is 
more than one 25%-or-more foreign owner, complete the fields for the person with the 
highest percentage of ownership.) Enter the percentage that person owned and the 
owner’s country of residence.

See section 6038A(c)(5) and the related regulations for the constructive ownership 
rules of section 318 that apply in determining if a corporation is foreign owned.

Schedule K, Line 13

On line 13 of screen K, select Yes if the corporation’s total receipts (line 1b + lines 4 
through 10 on page 1 of Form 1120) are less than $250,000 for the tax year, and its 
total assets at the end of the tax year are less than $250,000.

If the answer to line 13 is Yes, in the lower text box of line 13 enter the total amount of 
cash distributions and the book value of property distributions (other than cash) made 

NOTE
Generally, a 25% foreign-owned corporation with a reportable transac-
tion during the tax year must file Form 5472, Information Return of a 
25% Foreign Owned U.S. Corporation or a Foreign Corporation 
Engaged in a U.S. Trade or Business. See Form 5472 for filing instruc-
tions and penalties for failure to file.

NOTE
If another entity owns 20% or more of the client’s corporation, or owns 
50% or more of the corporation’s stock entitled to vote, see “Schedule 
K, Line 4” on page 19.
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during the tax year. (An entry here overrides the amount calculated from entries on 
line 5 (Distributions) on the M2 screen and reflected on page 4, line 13, of the 1120 
return.)

Schedule K-1

New in 2011, the 1120 package includes a K1P screen for entering information from 
Form 1065, Schedule K-1. This screen works the same as it does for the other pack-
ages, with amounts being carried automatically to the appropriate forms, schedules, 
and lines. In addition:

• Ordinary income is carried to Form 1120, page 1, line 10, “Other income,” with 
the partnership name and EIN (required information)

• Ordinary losses are carried to Form 1120, page 1, line 26, “Other deductions,” 
with the partnership name and EIN (required information)

Codes or lines not included require additional information not available to the pro-
gram and must be manually entered in the proper place in the return.

State-Specific Information

Resident State

The program automatically generates a return for the corporation’s resident state. Use 
screen 2 to enter company information as it should appear on the state return.

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state), and state-specific dates and num-
bers for identification.

Other States

Data for other states must be entered manually in state data entry. To access state data 
entry, select the States tab, or enter the two-letter state code in the selector field and 
press ENTER.

NOTE
If the answer on line 13 is Yes, the corporation is not required to com-
plete Schedules L, M-1, or M-2. To force the software to print these 
forms, go to the PRNT screen and select Force Schedules G (1120-
C), L, M-1, and M-2 to be printed.

NEW FOR

 2011
The link to screen 2 now appears under the States tab. (Or enter 2 in 
the selector field and press ENTER.)

NOTE The company information fields on screen 2 apply for the resident state 
only.
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Multi-State 
Appor-

tionment

New for 2011: Enter sales, payroll, and property factors on the APPT Multi-State 
Apportionment screen. This screen provides one central location for entering all state 
apportionment information instead of having to open each needed state’s screen. 

In addition to making data input faster and easier, the new feature provides two new 
worksheets: a summary worksheet (SA-SUM~) that can be used for verifying input, 
and a reconciliation worksheet (SA-REC) that ties the total of the state amounts to the 
federal return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake11 
but will be used to override data entered on the APPT screen. No state apportionment-
related screens will be updated from Drake10 to Drake11.

Figure 8: New APPT screens 

APPT Screens The new APPT screen is opened to the Sales tab. Links at the top of this screen take 
you to the Payroll, Property, and Additional Property information tabs for each 
state selected. These screens and their uses are listed in Table 1:

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists
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You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information will flow to that state’s return.

Click Screen Help on each tab for state-specific information.

Contact Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2. This screen has fields for the following types of contact 
information:

• Registered office

• Principal place of business

• “Books in care of”

• General contact information

Screen 2 also has fields for the name, title, e-mail address, ID number, and telephone 
number of the corporation’s contact person.

Access screen 2 from the States tab or by entering 2 in the selector field and pressing 
ENTER.

Other Information and Overrides

Use screen 1 to enter the following additional information:

Resident State — If the corporation has a mailing address in one state but does busi-
ness in another, select the state in which the corporation does business from the Resi-
dent State drop list.

Drake Codes and Overrides — Screen 1 includes fields for miscellaneous codes, 
invoice numbers, and several overrides. See “Listing a Different Firm, Preparer, or 

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake11 will become the Beginning amount for property on 
the APPT screen when the client’s return is updated next year in 
Drake12.
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ERO on a Return” and “Miscellaneous Codes” in Drake Software User’s Manual: Tax 
Year 2011 for more information.

Schedule L (Balance Sheet per Books)

Schedule L is required if the corporation’s total receipts for the tax year or its total 
assets at the end of the year are greater than $250,000.

Flow of Information

Many of the entries made elsewhere (such as inventory information from Schedule A) 
flow automatically to the generated Schedule L. Depreciable asset information from 
the 4562 screen and intangible assets and amortization also flow to Schedule L.

Use the corporation’s balance sheet to enter data directly onto Schedule L.

The SCH2 Screen

The SCH2 screen (see Figure 9) is used to provide detailed information required by 
the IRS for certain lines on Schedule L. The amounts are carried to Form 1120 and 
printed on an attached statement.

This screen can also be used in place of the actual L screen in Drake. If you use this 
screen for all applicable lines on Schedule L, you do not need to make any entries on 
screen L.

Entering 
Information

To create a statement for a line using the SCH2 screen, select the desired line from the 
Line Number drop list and enter descriptions and their corresponding amounts.

NOTE
Worksheets outlining these and other adjustment and override fields 
are accessible through the FAQs (Frequently Asked Questions) 
screen. For more information, see “Guide to Overrides and Adjust-
ments” on page 34.

NOTE See “Importing Trial Balance Information” on page 39 for information on 
using the trial balance import to enter Schedule L data.

NOTE To access the SCH2 screen from screen L, click an SCH2 Screen link 
or press CTRL and the number 2. Press ESC to return to screen L.
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Figure 9: SCH2 screen fields for line number, description, and amounts

Once the information is entered, or if additional descriptions are required for the line, 
press PAGE DOWN to access a new screen.

Statements The total amounts entered on the SCH2 screen do not show up on the actual L screen 
in the program. They are, however, printed on the return where needed, with refer-
ences to the corresponding statements.

The type of statement produced by the program depends on the selected line and the 
IRS requirements. If a line is required, a statement labeled “STATEMENT” is pro-
duced and is e-filed with the return. If a line is not required, a statement sheet 
(“STMT”) is produced and is NOT e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return.

SCH2 and 
Trial Balance 

Import 

Typically, one or more SCH2 screens are needed for Schedule L items. Data for the 
SCH2 screens cannot be entered directly into the trial balance worksheet. Although 
the amounts must be included in the trial balance worksheet for the worksheet to bal-
ance, the SCH2 detail screens must be created separately from the worksheet. When 
the return is produced, Schedule L will reflect both the amounts imported from the 
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 
screen amounts.

See “Importing Trial Balance Information” on page 39 for detailed instructions using 
the trial balance worksheet for SCH2 items and amounts.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital 
before the adjustment. For example, if assets are $1,000 and liabilities and capital are 
$900, the program increases the unappropriated retained earnings by $100.)

NOTE
All line selections and screen descriptions are carried to the next year, 
and year-end amounts are carried to the beginning-of-year column, 
when the returns are updated.
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The program makes the adjustments due to differences in the balance sheet. Incorrect 
data entry could cause these differences but they are usually the result of one of the 
following issues:

• An asset was deleted from 4562 screen (Depreciation Detail) instead of being 
indicated as sold.

• Beginning inventory amounts were adjusted on the Schedule A or ending inven-
tory amounts were entered incorrectly.

• Amounts were erroneously deleted or changed from screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Schedules M-1 and M-3 (Reconciliation of Income per Books)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year 
exceed $250,000 but are less than $10 million. Schedule M-3 is required if the balance 
sheet’s total assets at the end of the year equal or exceed $10 million.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, the corporation 
must reconcile book income with the taxable income.

Use the M1 screen schedule to enter book-to-tax difference for Schedule M-1. Book-
to-tax differences are classified as permanent or temporary, and as favorable or unfa-
vorable. Examples of both kind of differences are shown in Table 2.

NOTE If you are using trial balance import, autobalance must be turned off 
prior to import. See “Preparing to Use Trial Balance Import” on page 40.

NOTE If the corporation is filing Schedule M-3, any entries on the M1 screen 
(for Schedule M-1) should be deleted.

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not dur-
ing the same tax year

- Depreciation
- Gains or losses on the sale of
   depreciated assets
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Schedule M-3

Schedule M-3 is completed using the following screens, all found on the General tab 
of the Data Entry Menu:

• M3, M31, M32, and M33 — for Parts I, II, and III of the Schedule M-3

• M3B — for Schedule B Additional Information for M-3 filers

• SCH3 — for subsidiary schedules for Schedule M-3 and Form 8916-A

• M3S — for supplemental statements

• 8916 — for reconciling of M-3 with taxable income for mixed groups

• 916A — for supplemental attachments to the M-3

If the corporation is required to file (or voluntarily files) Schedule M-3, the corpora-
tion must file Form 1120 and all attachments and schedules, including Schedule M-3.

Parts I-III Part I of Schedule M-3 asks certain questions about the corporation’s financial state-
ments and reconciles financial statement worldwide net income (loss) for the corpora-
tion (or consolidated financial statement group, if applicable) as reported on Schedule 
M-3, Part 1, line 4, to net income (loss) per the income statement of the corporation 
for U.S. taxable income purposes, as reported on Schedule M-3, Part 1, line 11.

Parts II and III reconcile financial statement net income (loss) for the U.S. corporation 
(or consolidated tax group, if applicable) as reported on Schedule M-3, Part II, line 30 
(column d), to taxable income (loss) as reported on Form 1120, page 1, line 28.

The software carries certain items that are readily available, but it does not balance the 
M-3 automatically. To ensure that the M-3 balances, additional data entry may be 
required on the M31, M32, and M33 screens.

Schedule B Schedule B is required when an M-3 is present in a return. Use screen M3B for Form 
1120 Schedule B, Additional Information for M-3 Filers.

The SCH3 
Screen

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 

Favorable Items that reduce taxable income - Instances in which tax depreciation
  amount is greater than book depre-
  ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference Description Examples

NOTE
Certain income and deduction amounts and adjustments flow from 
Form 1120 to Schedule M-3 and Form 8916A in the program, but all 
other M-3 data must be entered manually.

If a Schedule M-3 is present in a return, no Schedule M-1 is generated.
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and 8916A screens. For more information on using this type of screen, see “The SCH2 
Screen” on page 24.

Schedule M-2 (Unappropriated Retained Earnings)

Information from Schedule M-2 Unappropriated Retained Earnings form ties to the 
Schedule L, line 25 portion of the balance sheet. Increases, distributions, and other 
decreases to the retained earnings are entered on Schedule M-2. Unappropriated 
retained earnings refer to corporate income that has not been distributed to sharehold-
ers that is available for dividend distribution.

M-2 Troubleshooting

The beginning Unappropriated Retained Earnings flows from Schedule L (Balance 
Sheet), and the Net Income (Loss) per books flows from the completed Schedule M-1 
or M-3 on Form 1120. These numbers, combined with amounts entered on the M2 
screen, are used to calculate the ending Unappropriated Retained Earnings.

If the computed amount does not match the amount in the completed Schedule L (Bal-
ance Sheet), the system produces an EF message that the M-2 is out of balance. Solv-
ing this problem can be challenging, since it can have one of several causes:

• The beginning balance sheet entries are inaccurate

• The Beginning of Year unappropriated retained earnings amount (line 25 on 
screen L) entered on the SCH2 screen for line 24 (Retained earning-Appropri-
ated) is incorrect

• Autobalance is not turned on (See “Autobalance” on page 25.)

• The ending balance sheet entries are inaccurate

• The net income per the tax return is inaccurate

• The reconciling items on Schedule M-1 or M-3 need to be adjusted

• The reconciling items on Schedule M-2 need to be adjusted.

If the items are off by a couple of dollars or less, resolve the problem by entering a 
reconciling item on the M2 screen:

1. Double-click in a field on the M2 screen to open a detail (CTRL+W) worksheet.

2. Enter an amount and the word “Rounding” as the description.

3. Press ESC. The program returns to the M2 screen.

If the problem is not resolved, it may be necessary to do a detailed comparison 
between the corporation’s financial records and the completed return information.
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Schedule O (Controlled Group Information)

Use screens O and OM, accessible from the first Other Forms tab, to fill out Sched-
ule O, Consent Plan and Apportionment Schedule for a Controlled Group. Press PAGE 
UP and PAGE DOWN to navigate from screen to screen.

AMT Adjustments and Other Items

Alternative Minimum Tax (AMT) adjustments are limited among the members of a 
controlled group. These should be entered in the Other information fields of the OM 
screen (Figure 10).

Figure 10: Other information fields for other AMT adjustments

Types of Controlled Groups

At the top of screen O, mark the box indicating the type of reported controlled group 
for which Schedule O is reporting. Controlled group types are briefly defined below. 
See Schedule O instructions for more details.

• Parent-subsidiary group — One or more chains of corporations that are con-
nected through stock ownership with a common parent corporation if certain con-
ditions apply.

• Brother-sister group — Two or more corporations if the same five or fewer per-
sons who are individuals, estates, or trusts directly or indirectly own stock of each 
corporation with a certain amount of voting power.

• Combined group — Three or more corporations, each of which is part of a par-
ent-subsidiary group or a brother-sister group, and one of which is (1) a common 
parent corporation included in a group in a parent subsidiary group, or (2) 
included in a group of corporations in a brother-sister group. 

• Life insurance companies only — Two or more insurance companies subject to 
tax under section 801, that are members of one of the previously described groups, 
are treated as a particular type of controlled group.

Line 5, Apportionment Plan Status

The corporation is required to provide information about the status of the group’s 
apportionment plan. Select the applicable box on screen O to show the status of the 
controlled group’s apportionment plan. If adopting a plan or amending the current 

NOTE Members of a controlled group are entitled to one $50,000, one $25,000, 
and one $9,925,000 taxable income bracket amount, in that order.
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plan for a prior tax year, at least one year must remain on the statute of limitations for 
each group member for assessing any resulting deficiency.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake 2011 carries 
the required adjustments to the appropriate line of the return and to Schedule M-1 or 
M-3. Manually reducing the expenses/deductions or increasing the income for these 
credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 6478, Alcoholic and Cellulosic Biofuel Fuels Credit

• Form 8864, Biodiesel and Renewable Diesel Fuels Credit

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8845, Indian Employment Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8844, Empowerment Zone and Renewal Community Credit

• Form 8932, Credit for Employer Differential Wage Payments

• Form 8941, Credit for Small Employer Health Insurance Premiums

Adjusting Charitable Contributions/NOL

Corporations with a net operating loss (NOL) carryover from any taxable year must 
apply the special rule of IRC section 170(d)(2)(B) for charitable contributions. The 
rules are designed to prevent a double tax benefit through interaction of NOL and 
charitable contribution carryovers. The excess charitable deduction can reduce taxable 
income only once. Under these rules, a corporation’s charitable contributions carry-
over (but not the NOL carryover) must be reduced to the extent the charitable contri-
bution deduction, in computing the taxable income of an intervening year, would 
increase the NOL to a succeeding year.

Limitation on 
Deduction

The total amount claimed cannot be more than 10% of taxable income (line 30) com-
puted without regard to the following:

• Any deduction for contributions

• The special deductions on line 29b
30 Tax Year 2011



Drake Software User’s Manual Supplement Elections
• The deduction allowed under section 249

• The domestic production activities deduction under section 199

• Any net operating loss (NOL) carryback to the tax year under section 172

• Any capital loss carryback to the tax year under section 1212(a)(1)

To prevent the double benefit from the excess charitable contribution deduction when 
there is a charitable contribution on the return and an NOL carryover, the program 
makes the IRC section 170(d)(2)(B) adjustment. In this situation, the charitable contri-
bution carryover amount is reduced on column C of the Contribution Limitation/Car-
ryover worksheet (WK_CNTRB in View mode), and the NOL carryforward is 
increased on the ATT_NOL worksheet.

Elections

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Return Elections section of the ELEC screen (Figure 11).

Figure 11: Return Elections portion of ELEC screen

Making an Election in Drake

To indicate that the corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list. (See Figure 12 on page 32.)
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Figure 12: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if a field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field shows that the field is 
required only for election options 08, 09, 11, and 15, and it explains what, specifi-
cally, should be entered for each of these elections.

Figure 13: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the 
election. For example, election 01 (General Election Statement) is generated as STM 
EL01.

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

NOTE
If the election option you selected is not listed in the help text for a field, 
then that field should be left blank. For example, if you chose election 
01 (General Election Statement), you would not need to enter anything 
into the Date or year-ending field (help text in Figure 13).
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Making Changes on the Fly

Use the PRNT screen to override most program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on-the-fly” changes override the options established 
in Setup.

You can force the program to print the following 1120 items on a return:

• Schedule E

• Schedules G (1120-C), L, M-1, and M-2

• Form 4562

• Next-year depreciation listing

• Inactive returns

• PIN for the preparer’s alternative electronic signature

The PRNT screen can also be used to suppress printing of the following items on a 
return:

• Form and attachment references (References are printed by default.)

• Form 4626, Alternative Minimum Tax—Corporations

Calculation and Other Options

The following calculation and other options are available:

• Calculate Form 2220 penalty — Select this box to have the program calculate 
the penalty for Form 2220, Underpayment of Estimated Tax by Corporations. 
(The program retains the rates as of 12/31 of the calendar year. If a corporation 
has a fiscal year end, the preparer must enter the effective rates manually.)

• Calculate WK_1120W based on 2011 taxable income — The WK_1120W is an 
estimated tax worksheet based on the current tax year taxable income.

• Calculate Form 4466 (application for quick refund) — Form 4466, Corpora-
tion Application for Quick Refund of Overpayment of Estimated Tax. (A check 
mark in this box is the only entry needed to generate the form.)

• Subchapter T Cooperative — Select this box to have the return treated as a Sub-
chapter T cooperative. When this box is selected, “Subchapter T Cooperative” is 
printed above the corporation name on page 1 of the return but the return does not 
become an 1120-C return.

• Turn off autobalance — For more information on the autobalance feature in 
Drake, see “Autobalance” on page 25.

NOTE
Schedule E is required if total receipts (line 1b + lines 4 through 10) are 
$500,000 or more.

Schedules L, M-1, and M-2 are not required if receipts and total assets 
(Schedule K, line 13) are less than $250,000.
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• Prepare Form 7004 extension based on screen 1 info — Select this box to pre-
pare a six-month extension based on the information that has already been entered 
into the return. Note that screen 1 must be completed to prepare an extension.

Overriding Other Setup Options

The following program defaults can be overridden from the PRNT screen:

• Filing instructions (federal and state)

• Envelope coversheets (corporation, IRS, state, and city)

• Date to print on return

• Due date to print on letter and filing instructions (see note below)

• Amount on Form 1120, page 1, item D (“Total assets”)

• IRS Service Center

Guide to Overrides and Adjustments

Available in the 1120 package are spreadsheets with information on overrides and 
adjustments in the business packages. These spreadsheets allow preparers to see what 
data or calculations are being affected when an entry is made in an override or adjust-
ment field. They can provide a better understanding of how overrides and adjustments 
work in the software.

To access the worksheets, click FAQ from any Data Entry Menu, and then click the 
Screen Help button at the top of the FAQ screen. Next, click the link for the desired 
worksheet and wait for the worksheet to be displayed as a PDF file.

Electronic Filing

Steps for e-filing Form 1120 are the same as for e-filing Form 1040, with the excep-
tion of bankruptcy returns, which must be paper-filed.

NOTE To prepare Form 7004 based on information other than (or in addition 
to) that provided on screen 1, use the 7004, or EXT, screen.

NEW FOR

 2011
A default due date for filing is printed on all letters and filing instructions 
generated with a return. You can now override the default by entering 
an alternate due date in the Due date to print on letter and filing 
instructions field on the PRNT screen.

NOTE

An Internet connection and Adobe Reader are required in order to view 
the worksheets.

Much of the information contained in the worksheets is also available 
from the field-level helps within the program. To access a field-level 
help, click inside a field and press F1, or right-click in a field and select 
View Help.
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Common Error Codes

If one or more of the following IRS error reject codes is generated when e-filing an 
1120 return, the preparer must contact the IRS for further information. The IRS e-Help 
Desk telephone number is (866) 255-0654.

• Reject Code 307 — Filer’s TIN and Name Control in the return header must 
match data in the e-File database unless Form 1120, Item E (3), check box “Name 
Change” is marked.

• Reject Code 900 — The return type indicated in the return header must match the 
return type established with the IRS for the EIN.

• Reject Code 905 — Electronic Filing Identification Number (EFIN) in the return 
header must be listed in the e-File database and in accepted status. If you get this 
reject code, you must update your e-file application to include the 1120 return 
type.

Figure 14: The 1120 box must be marked on Form 8633 in order to e-file Form 1120.

This can be done at the IRS website or by calling the IRS e-file Help Desk at (866) 
255-0654.

• Reject Code 910 — If “Amended Return” or (Superseded for 1120/1120S) check 
box is not selected, then Taxpayer TIN in the return header must not be the same 
as a TIN of a previously accepted paper return for the return type and tax period 
indicated in the tax return.

Special Types of Returns

This section covers 52-53–week year returns and inactive returns. Both types of 
returns can be e-filed using Drake.

Electing a 52-53–Week Year (Initial Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use MMDDYYYY format, as shown in the exam-
ple in Figure 15.

2. Mark the 52-53-week tax year box.
Tax Year 2011 35



Special Types of Returns Drake Software User’s Manual Supplement
Figure 15: In this example, the fiscal year begins 09/29/2011 and ends 09/26/2012
(the Wednesday closest to the end of September), giving the entity a 53-week year for 2011.

3. Click the ELEC link to open the Election Options screen (Figure 16).

Figure 16: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.

2. Under Items to Print, mark the Print inactive return box.

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the entity must use that account-
ing period every year. To change accounting periods, the entity must 
submit to the IRS Form 3115, Application for Change in Accounting 
Method.
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When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, on lines 1c and 2). Zeros are displayed where 
required by the IRS in order for amounts to be properly included in the e-file data.

For detailed instructions on e-filing returns in Drake, see Drake Software User’s Man-
ual: Tax Year 2011.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a PDF must be available to be 
attached to the return in order to be e-filed with the return.

Attach files through the PDF Attachments screen, accessible from the Electronic 
Filing section on the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached

2. Informing the program that a PDF file will be sent with the return

3. Attaching the PDF file for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return as a PDF.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Files

To indicate in the software that a PDF file will be sent with the return:

1. Go to the PDF screen in data entry.

IMPORTANT All EF messages must be cleared in order to e-file an inactive 
return.

TIP It’s a good idea to use the DDM scanning feature for this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF files if you have a PDF printer 
(such as Adobe Reader) installed.
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2. Fill out the columns on the screen. See Table 3 for examples.

3. Exit the PDF screen.

Because you’ve indicated that a PDF file is attached, the program generates an EF 
message page regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered on the PDF screen (see 
“Adding PDF Files,” previously), there will be three PDF–related items in the 
View/Print window:

• A red MESSAGES alert (see item 1 in Figure 17)

• An EF_PDF~ worksheet that lists all items entered on the PDF screen (see 
item 1 in Figure 17)

• An Attach PDF button on the toolbar (item 2 in Figure 17)

Figure 17: The red MESSAGES file and the Attach PDF button

2. Click MESSAGES file to view EF messages, which provide information on how 
to attach the required documents to the return.

3. Click the Attach PDF button in the toolbar at the top of the window. The EF PDF 
Attachments window displays the information entered on the PDF Attachments 
window in data entry. A red X means the document has not yet been attached; a 
green check mark indicates an attached document.

Table 3: PDF Attachment Window Columns

Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1120

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 18: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return, recalculate the return to make sure all EF messages have been 
cleared. If so, the return is ready to be e-filed.

Printing Generated Documents

In some instances, Drake generates a document that must be attached to the return. For 
example, if Form 851, Affiliations Schedule, is present in a corporate return, message 
0132 is generated when the return is calculated.

Figure 19: EF message regarding Form 851

As shown in Figure 19, the EF message states that attachments are required. You 
would then need to obtain or complete the statements, scan them into the computer, 
save them as a PDF file, and attach them to the return.

Importing Trial Balance Information

Drake’s trial balance import feature allows data to be imported into an 1120 return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation
Tax Year 2011 39



Importing Trial Balance Information Drake Software User’s Manual Supplement
Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake 2008 or later. If you haven’t already, create a client file in Drake or update an 
existing client file from the prior year. Like several other functions of the tax software, 
this new feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro security is set to “medium.” To do so, go to Tools > Options in Excel and 
select the Security tab. Click Macro Security and select Medium, and then click 
OK.

• Disable Autobalance — When autobalance is disabled, the program is prevented 
from automatically adjusting the year-end retained earnings or capital amounts, 
thus allowing you to see any discrepancies in the balance sheet. To disable auto-
balance, go to the PRNT screen and select Turn off autobalance.

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 
the case, you must override the default in order to have the amounts shown on 
Schedule L. To force the Schedule L amounts to be printed, go to the PRNT 
screen and select the applicable check box.

Figure 20: Check box for forcing Schedule L

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts or sales field on the INC screen; 
if a return has a detail worksheet for that field, the trial balance will not be 

NOTE A flow chart of the trial balance importing process is available as an 
appendix at the end of this manual.

NOTE
In Windows 7 and in Microsoft Vista, click the Office button in the upper 
left and then click the Excel Options button at the bottom of the win-
dow. Next, select Trust Center from the list at left, then click the Trust 
Center Settings button. Select Macro Settings from the list on the 
left, then choose Disable all macros with notification. Click OK.
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imported correctly into the return. Detail worksheets are indicated by red shading, 
as shown in Figure 21.

Figure 21: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 43 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial 
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

Naming 
Convention

Whenever a new template is opened, the tax software assigns it a default file location 
and name. Trial balance templates are saved in the TB folder of your Drake10 soft-
ware. The file name consists of the client name as entered in Drake, plus “TB” for 
“trial balance,” plus the “.xls” extension assigned to all Excel files, as shown in 
Figure 22 on page 42.

NOTE
In Windows 7 and Microsoft Vista, you may see a Security Warning 
message with an Options button. Click Options to open the Security 
Options dialog box, then select Enable this content. Click OK.
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Figure 22: Example of trial balance template file name

To change the name of a file in Excel, select File > Save As and assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 23; see also Figure 26 on page 44).

Figure 23: Schedule M-1 amount (1); totals (2); and indication of balance (3)

NOTE If saving a trial balance to a different location, make a note of where 
you’re storing it. The program automatically looks in the default directory.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Form, Page, Sch, and/or line Location of the amount on the printed return

Other information Additional details for preparers; see “Details for Pre-
parers” on page 46.
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Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0).

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons. (Buttons do not work if macros are disabled; see “Opening a 
Template” on page 41.)

Figure 24: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 25 on page 44 
shows an example of the “Other Income” worksheet.

NOTE
Some data cannot be imported from the trial balance and must be 
entered directly into the data entry fields within the program. For more 
on these categories of data, see “Special Conditions” on page 46.
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Figure 25: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the Corp TB tab (labeled “1” in Figure 25), 
or click the Return button above the worksheet tabs (labeled “2” in Figure 25). Note 
that a detail tab (the “Other Income” tab in Figure 25) might include one or more 
detail worksheets (labeled “3” in Figure 25).

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 26).

Figure 26: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

NOTE
Do not create detail worksheets in data entry if the trial balance work-
sheet does not provide an equivalent detail worksheet. Otherwise, the 
trial balance will not be imported correctly.

NOTE The data cannot be imported if the worksheet is out of balance.
44 Tax Year 2011



Drake Software User’s Manual Supplement Importing Trial Balance Information
Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. To re-name 
a file when saving, select File > Save As. For more information on file names in the 
trial balance program, see “Naming Convention” on page 41.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake, the trial balance 
information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. Use the Browse feature if nec-
essary. By default, each trial balance file is an Excel (.xls) file showing the client 
name and ending in “TB” for trial balance, as shown in the example in Figure 27. 
(See “Naming Convention” on page 41.)

Figure 27: Selected file to import

5. Select the Trial Balance Import Options. (See “Additional Import Options” fol-
lowing this procedure.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

NOTE
Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 46.

NOTE
If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake and start at Step 3 of 
the following procedure.
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Additional 
Import 

Options

The program can import the following additional information when importing the trial 
balance data: (Select the items to import or click Select All.)

Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake data entry. Other items should be entered into the work-
sheet for balance purposes but are not carried to data entry; these must be entered sep-
arately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items go directly to the location indicated in the program and on the 
return. For example, the amounts shown in Figure 28 go to Schedule L, line 1, column 
d in the program and are shown on page 5, line 1, column d of the 1065 return.

Figure 28: Indication of where an amount will go in Drake and on the return

Not all figures can be imported directly, however, and some amounts are optional. 
Drake has provided an “Other Information” column in the trial balance worksheet to 
indicate special conditions and additional information regarding certain rows. Table 5 
describes the most common notes in this column.

Buildings & other depreciable assets Accumulated depreciation

Goodwill & other intangible assets Land

Accumulated amortization

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake. Screen is specified in column 
to the left of “Other Information.”

optional Amount is optional; not required for import, but could require 
direct entry in the software.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases;” when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.
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All “does not import” notes are accompanied by further instructions in the column to 
the left of the “Other Information” column, as shown in Figure 29.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance.

Figure 29: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in data entry:

1. Open the SCH2 screen for the return.

2. Select the line number from the SCH2 drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat 
steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

Depreciation On an 1120 return, total depreciation consists of COGS depreciation, which is 
reported on Form 1125–A, Cost of Goods Sold, and any remaining depreciation, 
which is reported on page 1 of the return. For trial balance purposes, enter deprecia-
tion amounts directly into the appropriate fields on the trial balance worksheet.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Form 1125–A on the return. Because the remaining 
depreciation can comprise any number of assets, the amount entered on the trial bal-
ance does not flow to the return. To ensure that each component of the total remaining 

[Form or Schedule] may be 
required

Non-financial information (such as names of officers for a 
Schedule E) must be completed in Drake, in addition to the 
financial data entered in the worksheet.

Table 5: “Other Information” Column Notes

Note Description
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depreciation is calculated into the return, each asset must be entered on the applicable 
depreciation screens in data entry

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 at the bottom of the trial balance to the equivalent 
line on Schedule M-1 of the calculated return. If the depreciation 
amounts match but the line 1 amounts differ, an M-1 adjustment could 
be required.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporate tax return from a 
trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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‐ applicable detail worksheets
‐ totals for:

‐ depreciation
‐ Schedule L
‐ rentals (1120S & 1065 only)

Compare M‐1, line 1: Does trial balance 
match Schedule M‐1, line 1?Prepare to use Trial 

Balance Import

‐ Enable Excel macros
‐Disable autobalance
‐ Force Schedule L
‐Delete unnecessary detail worksheets

Did data
import 

correctly?

Make 
corrections in 
TB worksheet

NO

NO

Is an M‐1 
adjustment 
necessary?

Adjust 
amounts 

elsewhere in 
data entry

YES

Make 
adjustm

I
M
P
O
R
TPopulate Data Entry

Enter any trial balance data that cannot be 
imported via Trial Balance Import

‐ Screen SCH2 for Schedule L items
‐ Screen 4562 for individual assets

        (depreciation)

YES

NOYES

990, 990‐EZ, or 
990‐PF return?

YES

NO



Drake Software User’s Manual Supplement
Appendix B: Adjustment Worksheet

The Adjustment Worksheet is updated each year to help you understand what happens 
in the return when certain data is changed through the use of adjustment fields. The 
following pages contain the 2011 Adjustments worksheet.

These worksheets are also available through the FAQ screen. To access them, open 
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the 
links at the top of the window.
Tax Year 2011 B-1
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Client 
n/Line Field Name Location of Information Being Adjusted

come

a Gross receipts or sales Adjusts amounts from Schedule F, line 11 (if cash method is 
used) or line 45 (if accrual method is used).

5 Interest income Adjusts taxable interest income from Form 6252 when check 
box is selected.

7 Gross royalties Adjusts amounts from K1P screen, line 7.
eductions

9 Contributions Adjusts amounts from K1P screen, line 13, codes A and B.
9 Qualified conservation contributions Adjusts amounts from K1P screen, line 13, code G.

4 Employee benefit programs Adjusts the amount that flows from Schedule F, line 17, to this 
line.

8 Interest expense Adjusts the amount that flows from Schedule F, lines 23 (a) and 
23(b).

3  Pension, profit-sharing, and other plans Adjusts the amount that flows from Schedule F, line 25.

6 Rents Adjusts the amount that flows from Schedule F, lines 26 (a) and 
26 (b).

4 Repairs and maintenance Adjusts the amount that flows from Schedule F, line 27.

3 Salaries and wages paid to non-shareholder 
employees Adjusts the amount that flows from Schedule F, line 24.

1 Other miscellaneous taxes Adjusts the amount that flows from Schedule F, line 31
125-A - Cost of Goods Sold
1 Inventory at beginning of year Adjusts amount coming from Schedule F, line 46. 
2 Purchases Adjusts amount coming from Schedule F line 47.
4 Additional section 263A costs Adjusts amounts coming from K1P screen, line 13, code P.
7 Inventory at end of year Adjusts amount coming from Schedule F, line 49.
le C - Dividends and Special Deductions
7 Adjusts amounts coming from K1P screen, line 6a.
le K - Other Information

/13 If YES, enter the total amount of cash distributions and 
the book value of property distributions here

Adjusts amounts entered on M-2 screen for lines 5a, 5b and/or 
5c.

le M-1 - Reconciliation of Income (Loss) per Books With Income per Return
4 Income subject to tax not on books Adjust the amounts coming from Forms 6478 and 8864.

5 Expenses recorded on books but not deducted on 
Form 1120 : Other

Adjust amounts credit adjustments made from Forms 5884, 
5884A, 6765, 8820, 8845, 8846, 8881, expense amounts 
subject to limitations, and nondeductible expenses carry 
automatically to this line. 

7 Income recorded on books but not included on Form 
1120: Other Adjusts amounts from K1P screen, line 18, code B.

Recapture of Low-Income Housing Credit
8 Recapture amount from pass-through entity Adjusts amounts from K1P screen, line 20, code F and G.
art 1
0 Carryover of disallowed deduction from prior year Adjusts amounts from the 4562 screen.
120-H

1 Tax credits Adjusts credit amounts carrying from Form 8834 and Form 
3800.

626 - Alternative Minimum Tax - Adjustments & Preferences

a Depreciation of post-1986 property Adjusts calculated amount for current regular expense and AMT 
depreciation expense reported on Fed_Depr.

e Adjusted gain or loss Adjusts amounts from K1P screen, line 17, code B.
l Depletion Adjusts amounts from K1P screen, line 17, code C.
n Intangible drilling Costs Adjusts amounts from K1P screen, line 17, codes D and E.
o Other adjustments and preferences Adjusts amounts from K1P screen, line 17, code F.
903 - Domestic Production Activities Deduction

7 Qualified production activities income from pass-
through entities Adjusts amounts from K1P screen, line 13, code U.

7 Form W-2 wages from pass-through entities Adjusts amounts from K1P screen, line 13, code V.
Bill - Adjustments and Payments

Adjustments: Amount Adjusts amount to be printed on the client's bill; corresponds to 
the description on the BILL screen.

     Adjustments Worksheet
 Adjustment Location

Form 1120
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Appendix C: Override Worksheet

The Override Worksheet is updated each year to help you understand what happens in 
the return when certain data is changed through the use of override fields. The follow-
ing pages contain the 2011 Override worksheet.

These worksheets are also available through the FAQ screen. To access them, open 
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the 
links at the top of the window.
Tax Year 2011 C-1
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1
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8a/1

8b/1
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10/1

11a/1

11a/1

11b/1

11b/1
n/Line Field Name Location of Information Being Overridden 

oration General Information screen
Preparer fee Overrides the fee calculated by the software. The fees are 

entered in Setup > Pricing.
Firm number Overrides the default selection (1) 
Preparer number Overrides the default selection (1)
Data entry op # Overrides the default setting (the login name)

ERO number Overrides the selection made from the ERO SSN Indicator drop 
list at Setup > Options, EF tab.

eductions

2 Officer Compensation Overrides amounts entered on screen E in Compensation of 
Officers field.

1 State income taxes Overrides state income taxes calculated from information 
entered on ES screen using the code IN.

2 State franchise  taxes Overrides state franchise taxes calculated from information 
entered on ES screen using the code FR.

125-A - Cost of Goods Sold

5 Depreciation Overrides calculated amount for entries on 4562 detail screen 
directed to the COGS in the Form selection box.

le J - Loss Carryback, Tax Computation, and Payments

2 Prior-year overpayment credited to current year Overrides entry made on ES screen

3 Estimated tax payments for current year Overrides the estimated tax payments for TY 2011 entered on 
the ES screen.

4 Prior year's refund applied for on Form 4466
Overrides amount coming from Form 4466 to line 32c of Form 
1120 . Go to PRNT (Print Options) screen and select the option 
Calculate Form 4466.

6 Tax deposited with Form 7004 (extension application)
Overrides amount entered on screen 7004 - Application for 
Automatic Extension for Form 1120, "Amount paid with 
extension."

le K - Other Information

/9 Tax-exempt interest received or accrued during the tax 
year

Overrides the amount of tax-exempt interest entered on the INC 
screen.

le L - Balance Sheet - Assets

3b Inventories Overrides entries from screen A - Cost of Goods Sold, line 1 
Inventory at beginning of year.

(d) Inventories Overrides entries from screen A - Cost of Goods Sold, line 7 
Inventory at end of year.

0a (a) Depreciable assets Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

0a (c) Depreciable assets Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

0b (a) Accumulated depreciation Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

0b (c) Accumulated depreciation Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

2 (b) Land Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

2 (d) Land Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

3a (a) Intangible assets Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

3a (c ) Intangible assets Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

3b (a) Accumulated amortization Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

3b (c ) Accumulated amortization Overrides calculations from on the 4562 detail screen or the 
Subsidiary Schedule for the Balance Sheet (SCH2 screen).

     Overrides Worksheet
Override Location

1120
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     Overrides Worksheet
Override Location

1120
le M-1 - Reconciliation of Income (Loss) per Books With Income per Return

2 Federal income tax Overrides the systems calculation based on taxable income.

5 Expenses recorded on books but not deducted on 
Form 1120

Overrides the book-to-tax depreciation adjustment calculated by 
the system. 

8 Deductions on form 1120 not charged against book 
income

Overrides the book-to-tax depreciation adjustment calculated by 
the system. 

le M-3 - Net Income/Loss Reconciliation

a Income statement period - Beginning Overrides default calendar year dates or fiscal year dates 
entered on screen 1

a Income statement period - Ending Overrides default calendar year dates or fiscal year dates 
entered on screen 1

916 - Reconciliation of Sch M-3 with Taxable Income for Mixed Groups

1 Sch M-3 tax reconciliation amount from Pt. II, line 30, 
column (d)

Overrides amount calculated by the system for Part II, line 30, 
column (d).

lectronic Funds Withdrawal Information

Federal payment amount Overrides amount calculated by the software for line 34 of Form 
1120: "Amount Owed."

Federal : Requested payment date Overrides federal return due date.
Federal Daytime phone number Overrides phone number entered on screen 1 (General Info)
State payment amount Overrides amount calculated by the software.
State: Requested payment date Overrides state's return due date or date the return is filed
State: Daytime phone number Overrides phone number entered on screen 1 (General Info)
State payment amount Overrides amount calculated by the software.
State: Requested payment date Overrides states' return due date or date the return is filed
State: Daytime phone number Overrides phone number entered on screen 1 (General Info)
State payment amount Overrides amount calculated by the software.
State: Requested payment date Overrides state's return due date or date the return is filed
State: Daytime phone number Overrides phone number entered on screen 1 (General Info)

ptions

Print federal filing instructions Overrides the option selected in Setup > Options, Optional 
Documents tab, for the federal filing instructions.

Print state filing instructions Overrides the option selected in Setup > Options, Optional 
Documents tab, for the state filing instructions.

Print corporation's envelope coversheet Overrides the option entered in Setup > Options, Optional 
Documents tab, for the corporation envelope coversheet.

Print IRS envelope coversheet Overrides the option entered in Setup > Options, Optional 
Documents tab , for the IRS envelope coversheet.

Print state envelope coversheet Overrides the option entered in Setup > Options, Optional 
Documents tab, for the state envelope coversheet.

Print city envelope coversheet Overrides the option entered in Setup > Options, Optional 
Documents tab, for the city envelope coversheet.

Date to print on returns
Overrides the default date on the "Paid Preparer" line at the 
bottom of the 1120, page 1, the 1120-C, the 1120-H, the letter, 
and the 8879 .

Due date to print on letter and filing instructions Overrides the default due date that is printed on letters and filing 
instructions.

Total assets on Form 1120, page 1, line D Overrides the amount calculated by the software for Form 1120, 
page 1, line D.

IRS Service Center
Overrides the IRS Center address determined by the program 
based on the corporation's location and amount of total assets at 
the end of the year.

etail

Override regular depreciation,   Federal Overrides the system calculation for the "Current depr" column 
of the Depreciation Detail Listing.

Override regular depreciation,   AMT (if different) Overrides the system calculation for the "AMT Current" column 
of the Depreciation Detail Listing.

Override regular depreciation,   Book (if different) Overrides the calculated book amount.
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     Overrides Worksheet
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1120
179 expense elected this year,  Federal Overrides Form 4562, Part I, line 6, column (c) and the amount 

for the WK_C179L

179 expense elected this year,   Book (if different) Overrides the calculated book amount and the amount for the 
WK_C179L..

179 expense ALLOWED this year,   Federal

Overrides Form 4562 line 12 (If Method M is chosen there must 
be an entry made on line 179 expense elected this year or 
Method EXP must be used). Overrides amount calculated for 
WK_C179L.

179 expense ALLOWED this year,   Book (if different) Overrides the calculated book amount and the amount for the 
WK_C179L.

rce 
ntion" Placed in Service and Like-Kind Exchange Info Overrides convention determined by the dates of assets placed 

in service during the year.

ot use 
RS % 
les"

Placed in Service and Like-Kind Exchange Info Overrides how the system calculates depreciation for the "Life" 
and "Method" columns of the Depreciation Detail Listing.

art 1

1 1 Maximum amount if greater than $250000 Overrides the maximum of 179 expense for 2009 of $250,000 on 
line 1 of Form 4562

2 2 Total cost of sec 179 property placed in service in 
current year

Overrides the software calculated amount of section 179 
property placed in service during the tax year.

3 Total business income  Federal Overrides line 5 on WK_C179L
oreign Tax Credit Schedule B, Part II

1 Total foreign taxes paid or accrued Overrides calculated amount from Form 1118, Schedule B, Part 
I, column 2h.

2 Total taxes deemed paid Overrides calculated amount for Form 1118, Schedule B, Part I, 
column 3.

3 Reduction of taxes paid, accrued, or deemed paid Overrides amount carried from Schedule G.

5 Carryback or carryover of excess foreign taxes Overrides amount on Schedule K, line 3, column XIV.

7 Schedule J, Part I, line ii (if Sch J is required) Overrides amount on Schedule J, Part I, line 11, or Schedule A, 
column 13.

Parts I & II, Current Year Credits

3 25% of the excess, if any, of line 14 over $25,000
Overrides amount calculated by the software for Form 3800, Part 
II, line 13. This field is used for allocation of the total amount for 
controlled groups.

7a If there has been an ownership change, acquisition, or 
reorganization

Overrides amount calculated by the software for Form 3800, Part 
II, line 19a.

468

a
Qualifying advanced coal project credit, Basis of 
investment in gasification for section 49A(d)(3)(B)(i) 
projects

Overrides the cost entered on the 4562 detail screen as 
determined by the code (CA) entered in the Investment credit 
code drop list.

b
Qualifying advanced coal project credit, Basis of 
investment in coal-based generation for section 
49A(d)(3)(B)(ii) projects

Overrides the cost entered on the 4562 detail screen as 
determined by the code entered in the Investment credit code 
drop list.

b Qualifying gasification project credit, Basis of 
investment property not included in (a) above

Overrides the cost entered on the 4562 detail screen as 
determined by the code entered in the Investment credit code 
drop list.

1e Rehabilitation property, Pre-1936 buildings in the Gulf 
Opportunity Zone

Overrides the cost entered on the 4562 detail screen as 
determined by the code (RA) entered in the Investment credit 
code drop list.

1g Rehabilitation property, Other pre-1936 buildings
Overrides the cost entered on the 4562 detail screen as 
determined by the code (RB) entered in the Investment credit 
code drop list.
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1120

1h Rehabilitation property, Certified historic structures in 
the Gulf Opportunity Zone

Overrides the cost entered on the 4562 detail screen as 
determined by the code (RC) entered in the Investment credit 
code drop list.

1j Rehabilitation property, Other certified historic 
structures

Overrides the cost entered on the 4562 detail screen as 
determined by the code (RD) entered in the Investment credit 
code drop list.

2a Energy Credit, Basis of property using geothermal 
energy placed in service during 2009

Overrides the cost entered on the 4562 detail screen as 
determined by the code (EA) entered in the Investment credit 
code drop list.

2b
Energy Credit,                  11b Basis of property using 
solar illumination or energy placed in service during 
2009

Overrides the cost entered on the 4562 detail screen as 
determined by the code (EB) entered in the Investment credit 
code drop list.

2c Energy Credit,                  11c Qualified fuel cell 
property: Basis of property installed

Overrides the cost entered on the 4562 detail screen as 
determined by the code (EC) entered in the Investment credit 
code drop list.

2i Energy Credit, Qualified microturbine property: Basis of 
property installed

Overrides the cost entered on the 4562 detail screen as 
determined by the code (ED) entered in the Investment credit 
code drop list.

478

2 Alcohol 190 proof or greater and alcohol 190 proof or 
greater in fuel mixtures Overrides the default rate. Refer to the form instructions.

3
Alcohol less than 190 proof  but at least 150 proof and 
alcohol less than 190 proof but at least 150 proof in 
fuel mixtures

Overrides the default rate. Refer to the form instructions.

4 Qualified cellulosic biofuel produced after 2008 that is 
alcohol Overrides the default rate. Refer to the form instructions.

609 - Low-Income Housing Credit Allocation Certification

2 Schedule A - Annual Statement, Override of computed 
rate Overrides computed rate on Form 8609A, Part II, line 2.

827 - Credit for Prior Year minimum Tax

a Section 383 or Section 384 Amounts Overrides the amount calculated for Form 8827, line 8a if the 
corporation has special items. See Form 8827 instructions.

le K-1 for 1065

Current Year 179 exp allowed Overrides the allowed amount calculated on the WK_S179L 
worksheet.

Prior year 179 exp allowed Overrides the allowed amount calculated on the WK_S179L 
worksheet.

Prior year QRP 179 exp allowed Overrides calculated amount.
Application for Employer Identification Number

County & state Overrides information entered on screen 1.
Date business started/acquired Overrides information entered on screen 1.

m 1120W - Corporation Estimated Tax
1 Taxable income expected for the tax year Overrides amount coming from Form 1120, page 1, line 30.

5 Alternative minimum tax Overrides amount flowing from the Form 4626, line 14.

3a Tax shown on current year tax return Overrides amount calculated by the software for Form 1120, line 
30

5 Required installment amounts Overrides amount calculated by the software for Form 1120W, 
line 25, column (a)-(d)

5 Overpayment applied Overrides amount calculated by the software for Form 1120W, 
line 25, columns (a)-(d).

120X - Amended U.S. Corporation Income Tax Return
1 Total Income Overrides amount from original Form 1120, line 11.
2 Total deductions Overrides amount from original Form 1120, line 27.
4 Tax Overrides amount from original Form 1120, line 31.
a Overpayment in prior year allowed as credit Overrides amount from original Form 1120, line 32a.
b Estimated tax payments Overrides amount from original Form 1120, line 32b.
c Refund applied for on Form 4466 Overrides amount from original Form 1120, line 32c.
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     Overrides Worksheet
Override Location

1120
e Tax deposited with Form 7004 Overrides amount from original Form 1120, line 32d.
f Credit from regulated investment companies Overrides amount from original Form 1120, line 32f(1).
g Credit for federal tax on fuels Overrides amount from original Form 1120, line 32f(2).

6 Tax paid with/after original return Overrides amount from original Form 1120, line 34.
8 Original overpayment or as later adjusted Overrides amount from original Form 1120, line 35.
Application for Tentative Refund for Current-Year Loss Carryback

c Service Center Overrides the IRS Service Center determined by the program 
based on the location and amount of total assets.

220 - Underpayment of Estimated Tax (Screen 1 of 2)
0 OVERRIDE installment amounts Overrides amount carried from ES screen.
553 - Election by a Small Business Corporation 

Officer title for signature section Overrides the entry made in Part I, line H, Title, on screen 2553.

115 Change in Accounting Method
General Information - Principal business activity code 
number Overrides selection made on screen K, line 2a.

Tax year of change begins Overrides default calendar year dates or fiscal year dates 
entered on screen 1.

Tax year of change ends Overrides default calendar year dates or fiscal year dates 
entered on screen 1.

Contact person's telephone number Overrides entry made on screen 1.
 II, IV, 
e 25 Net Section 481(a) adjustments for the year of change Overrides amount flowing from Form 3115, section A, line 1h.

626 - Alternative Minimum Tax

c Member's reduced share Overrides the calculated amount for line 8c for members of 
controlled groups. See Form 4626 instructions.

471 SCHI Schedule I and Worksheets
1 Subpart F income Overrides calculations from worksheets A -D.
2 Earnings invested in US property Overrides calculations from worksheets A -D.

3 Previously excluded subpart F income withdrawn from 
qualified investments Overrides calculations from worksheets A -D.

4 Previously excluded export trade income withdrawn 
from investment in export trade assets Overrides calculations from worksheets A -D.

1 Worksheet A - Shareholder's pro rata share of line 30 Overrides calculated amount.

8b Worksheet A - Average exchange transaction rate Overrides rate entered on 5471 screen.

4 Worksheet B - U.S. shareholder's pro rata share of 
U.S. property held Overrides calculated amount.

3 Worksheet B - U.S. shareholder's pro rata share of line 
12 Overrides calculated amount.

7 Worksheet B - Year-end spot translation rate Overrides rate entered on 5471 screen.

5 Worksheet C - U.S. shareholder's pro rata share of line 
4 Overrides calculated amount.

b Worksheet C - Average exchange translation rate Overrides rate entered on 5471 screen.
2 Worksheet D - Pro rata share of line 1 Overrides calculated amount.
b Worksheet D - Average exchange translation rate Overrides rate entered on 5471 screen.
472 - 25% Foreign-Owned U.S. Corporation

j Country of Incorporation Overrides entry on screen 1 for foreign address if "." is entered in 
ST field.

004 - Application for Automatic Extension for Form 1120

6 Tentative tax before credits (Payments/Credits) Overrides calculated amount on Form 1120, page 1, line 31; 
Form 1120-C, line 28; Form 1120-H, line 22.

7 Total payments and credits Overrides calculated amount on Form 1120, page 1, line 32h; 
Form 1120-C, line 29; Form 1120-H, line 23g.

027 Employer's Annual Information Return of Tip Income and Allocated Tips

7 Allocation of tips if using other than calendar year Overrides calculated amount for line 7 of form; place X in line 6 
to activate this override.

082 - Notice of Inconsistent Treatment or Administrative Adjustment Request (AAR)
7 Corporation's tax year Overrides the dates entered on screen 1.
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Override Location

1120
716 - Election to Have a Tax Year Other Than a Required Tax Year
4 Date of required tax year Overrides calculated date based on return type election.
822B - Change of Address
a Business name Overrides information entered on screen 1.
b Employer ID number Overrides information entered on screen 1.

6 New mailing address Overrides information entered on screen 1.
8 Daytime phone number Overrides information entered on screen 1.
873 - Extraterritorial Income Exclusion
a Business activity code Overrides information flowing from the Schedule K, line 2.
b Product Overrides information flowing from the Schedule K, line 2c.

5 Part IV
Overrides calculated results for line 42: override and enter 
amounts from lines 33, 36, 38, or 44, when using alternative 
computation.

903 - Domestic Production Activities Deduction

1 Income limitation
Overrides program calculations for Form 8903, line 11 from 
Form 1120, line 28 (adds back 8903 DPAD amount from Form 
1120, line 25).

925 - Report of Employer-Owned Life Insurance Contracts

Type of business Overrides entries made on K screen, line 2 (Business activity)

Bill - Adjustments and Payments
Billing option (overrides what is set up in options) Override the option selected in Setup > Options, Billing tab.

Custom paragraph option (overrides what is setup in 
options)

Override the option selected in Setup > Options, Billing tab.

Date to be printed on bill Overrides current date.
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Index

A
address

change of 7
e-mail 23
entering on Form 1120 5

adjustment fields 34
adjustments and credits 30
advertising expenses 13
affiliated groups 19
alternative minimum tax (AMT) 29
amended returns 18
amortization 13, 24
apportionment

plan status 29
attachments

binary 37–39
PDF, see PDF files

auto-balance 25, 33

B
bad debts 10, 11
bankruptcy 34
Book Depreciation 4
book-to-tax difference (Schedule M-1) 26
brother-sister group 29

C
calendar years 6
capital gains and losses 9
carryover of NOLs 14, 30
change of name or address 7
Changes on-the-fly 33
charitable contributions 12, 30
codes

error/reject 35
miscellaneous (screen 1) 23
state 21

combined group 29
compensation of officers 10
consolidated returns 9
contact information (for state returns) 23
contributions, charitable 12, 30
controlled groups 14, 29
converting to 1120 5
cost of goods sold, see  Schedule A (Cost of Goods Sold)
coversheets 34

credit for tax on fuels 10
credits and adjustments 30
Ctrl+W (detail) worksheets 8, 14, 40

D
data entry

FAQ screen 34
trial balance import 43

debts, bad 11
deductions and income 7–14
depletion 13
depreciation

and auto-balance errors 26
expense 12
for cost of goods sold (Schedule A) 8
on short-year returns 6
trial balance (business returns only) 47

detail (Ctrl+W) worksheets 8, 14, 40
direct debit of balance due 15–16
Domestic Production Activities 13
domestic production activities deduction 13

E
e-filing

new features in Drake 34
PDF documents 37–39

electronic
funds withdrawal (direct debit) 15
signatures (PIN) 17

entertainment and meals 14
envelope coversheets 34
error codes 35
estimated tax worksheet 33
estimates 14, 33
extensions 16–17, 34

F
filing instructions 34
final returns

indicating in the program 7
updating 5

fiscal year returns 6
foreign ownership 20
Form 1099-K (Merchant Card and Third-Party Network 

Payments) 7
Form 11125-E 3
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Form 1120-C (U.S. Income Tax Return for Cooperative 
Associations) 5

Form 1120-H (U.S. Income Tax Return for Homeowners 
Associations) 5

Form 1125-A 3
Form 2220 (Underpayment of Estimated Tax By Corpora-

tions) 15, 33
Form 3800 2
Form 4466 (Corporation Application for Quick Refund of 

Overpayment of Estimated Tax) 15, 33
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